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[bookmark: _Toc440460974][bookmark: _Toc440465396]Learning outcomes
By the end of this workshop, you will be able to:

· Select efficient methods and tools for finding information in your subject area
· Obtain information using appropriate methods
· Define and apply criteria for evaluating information
· Record, organize and share information with the reference management software EndNote
· Conform with conventions and etiquette related to the use of information (copyright law and plagiarism)
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Part I 
Search and Evaluate

[bookmark: _Toc440465397]Where to find pertinent tools for finding information
The Uni Arve Library website is the main portal to access tools useful for finding information in your subject area. Librarians and academics selected licensed and free resources for each research area in sciences:

www.unige.ch/biblio/sciences

[image: ] 

On the subject pages of the library website, you will find different types of resources. Information you obtain varies from one tool to another. Be aware of these differences when you are performing researches.

	Resource type
	What you can find
	Examples

	Bibliographic database
	Bibliographic references of scientific publications (journal articles, conference proceedings, etc.) related to a subject area; research with keywords
Watch out: only link to full-text!
	Web of Science
PubMed
SciFinder

	Editor’s database
	Bibliographic references AND full-text articles published in all journals of a specific editor
	ScienceDirect (Elsevier)
Springer Link

	Subject-oriented open repository
	Bibliographic references AND full-text of scientific publications (journal articles, conference proceedings, etc.) related to a subject area
Specificities: publication submitted by the authors themselves, sometimes before or after the official publication in a journal → free access
	ArXiv
BioArXiv

	Institutional open respository
	Bibliographic references AND full-text of scientific publications (journal articles, conference proceedings, etc.) of authors of one institution
Specificities: publication submitted by the authors themselves, sometimes before or after the official publication in a journal → free access
	[image: C:\Users\melliflu\AppData\Local\Microsoft\Windows\Temporary Internet Files\Content.Word\noun_1199.png]Archive ouverte UNIGE
CERN Document Server

	Discovery tool
	Meta-tools to perform a search in all types of resources described above in one time
	RERO Explore Genève

	Library catalog
	References and localization of printed books or journals available in a library or in a libraries’ network
Watch out: no articles’ references! 
	Catalogue du réseau des bibliothèques genevoises

	A-Z list of electronic journals
	List of electronic journals licensed by an institution (e.g. UNIGE); used to access full-text of an article when you have a complete reference
Watch out: search for a journal title!
	Liste A-Z des revues électroniques de l’UNIGE







Using the library website, identify relevant resources you could use to find information for your doctoral thesis:
	
SEARCH TOOLS AND RESOURCES FOR MY PHD


	Search Tool
	What can I find?
	Advantages
	Limitations

	




	
	

	

	




	
	

	

	




	
	

	

	




	
	

	


[image: H:\_icones_diverses\astuce.png]


Several of these resources are licensed by the UNIGE, so you have to be on the UNIGE computer network to access them:
 computers in your lab or in the library
 connection to the wireless network "unige" (wifi)

If you are outside the University, you have to install a software called VPN (Virtual Private Network), so you can access UNIGE electronic resources as if you were in UNIGE premises.
To install VPN on your private computer:
1. Go to: http://etugdl.unige.ch
2. Log in with your UNIGE account
3. Look for the VPN Client software corresponding to your operating system
4. Click on the button “Charger” (on the right) to download the software and follow the installation instruction for your operating system by clicking on the [image: http://gdl.unige.ch/WebObjects/etudGDL2.woa/Contents/WebServerResources/help.gif] on the left

[bookmark: _Toc440465398]How to prepare your research to get best results
Before going on a database and perform a research, it is important to prepare your topic in order to avoid:

· Wasting time
· Finding information not relevant for your needs
· Getting lost in a huge mass of information

To find relevant information on your topic, you must translate your research question into keywords that you will then use when searching various databases.

Example of research topic translated into keywords presented with a mindmap:


[image: ]


[image: H:\_icones_diverses\astuce.png]


To find relevant keywords and their synonyms (sometimes antonyms), use these tools:
 dictionaries and encyclopedias (general and scientific)
 thesaurus of databases (e.g. MeSH in PubMed)
 keywords present in documents you have already found


Another way to gather keywords is to build a table with all your keywords:

My Search Topic
How is mass spectrometry used for detection of doping in sport?

Key concepts

	mass spectrometry
	OR
	mass spectroscopy
	OR
	mass spectrum analysis
	
	
	
	

	AND
	
	
	
	
	
	
	
	

	doping
	OR
	drug abuse
	OR
	drug use
	OR
	drug testing
	OR
	antidoping testing

	AND
	
	
	
	
	
	
	
	

	sport
	OR
	competition
	OR
	athletics
	

	
	
	





Try to fill in the following table with keywords for your doctoral thesis:

My Search Topic
	
                      



Key concepts

	
	OR
	
	OR
	

	OR
	
	OR
	

	AND
	
	
	
	
	
	
	
	

	

	OR
	
	OR
	
	OR
	
	OR
	

	AND
	
	
	
	
	
	
	
	

	

	OR
	
	OR
	
	OR
	
	OR
	


[bookmark: _Toc440465399]
Search tips to get good results in bibliographic databases

· Always keep note of all steps in your research (see p.9 for a sample table).
· Use boolean operators AND, OR, NOT to join search topics in databases interfaces (except in SciFinder, the database for chemistry!). 
· Is it possible to search for controlled index terms in the database you are using? In PubMed for instance, you can look for concepts in the MeSH thesaurus.
· Do you already have a relevant reference on your subject? If it is the case, you can try to use the related references search option of the databases (e.g. “get cited references” or “get citing references”).
· Choose an appropriate sort order of the reference (if available): by date to find the most recent publications or by times cited for the most popular ones

If you have TOO MANY results:

· Could you use the filtering options of databases interfaces to restrict the timespan of your search? Maybe you want only publications of the last 10 or 5 years.
· Which languages can you read? Some databases allow you to choose only publications in English or in French for instance.
· Are you looking for a specific document type? “Reviews” or “General Reviews” are state of the art articles convenient to begin reading on a topic which is new to you.

If you have TOO FEW results:

· Check your spelling!
· Maybe are your search terms too specific? Try to use more general search terms.
· Think of synonyms.
· Use the truncation, usually with the sign *, to search all terms with the same basis: scien* → science, scientific, scientist…
· Is the database you are looking in really relevant for your subject? 



Always remember:
A single database is not sufficient to perform an exhaustive search.
Bibliographic search is an iterative process.


Sample table to save your searches:
	DATABASE USED:
	


	> Date of research:
	

	
	

	> Search query: 
(+ search mode if relevant)
	



	> Limitations:
	



	> Nb of results:
	

	> Relevant references found:

	











	
	

	> Search query: 
(+ search mode if relevant)
	



	> Limitations:
	



	> Nb of results:
	

	> Relevant references found:
	

	














[bookmark: _Toc440465400]How to obtain the full-text
1. How complete is your reference?

A. Your reference is not complete:
Use a bibliographic database, like Web of Science, Google Scholar, PubMed, SciFinder, etc. to retrieve the complete reference.

[image: ] This button allows you to access full text from UNIGE.

B. Your reference is complete:
Use directly the discovery tool RERO Explore Genève: explore.rero.ch/ge.
In this database, it is possible to look for the title of the article for online publications.

[image: ]


C. You have the DOI (Digital Object Identifier):
Go to doi.org and enter your DOI in the search box:

[image: ]



2. You don’t have access to your article online

A. Check if we have access to the printed form at the library using RERO Explore Genève. Go to the “Advanced search”, choose “Journal title” in the dropdown menu and enter the title of the journal you are looking for.

In the list, click on the “Details” panel of the title of interest to check its location and availability:

[image: ]


B. If you can’t find either online or printed version of the journal, use our Document Order Service: www.medecine.unige.ch/organisation/bfm/openillink. 

The service is free for the UNIGE community if the document is available in a Swiss library.

C. Otherwise, try your luck with Google Scholar (scholar.google.com). It can give you access to uploaded publications (sometimes illegally) on institutions’ repositories or other document servers like ResearchGate:

 [image: ]

D. As a last resort, try to contact the corresponding author to ask for a copy of the paper.



[bookmark: _Toc440465401]How to keep up-to-date about new publications
There are different ways of tracking new information on sources of interest (e.g. journal titles or results of a database research) without visiting them on regular basis:

· Creating email alerts
· Subscribing to RSS feeds
· Using social media (e.g. Twitter)

In order to avoid submerging you email box with a lot messages, we advise you to use a RSS reader (or RSS aggregator) and subscribe to RSS feeds when possible.

[image: http://3.bp.blogspot.com/-jCx9XnEElaI/VEKaaENWsyI/AAAAAAABSNM/j7N-Ctrnd0M/s1600/logo_mobile_large.png]
Example of an online and free RSS aggregator: 


With an RSS aggregator, you will be able to subscribe to news from websites like:

[image: ]

Unfortunately, it is not possible in all sources: it depends of website functionalities offered by the editors.

Visit the most relevant databases, journal or website in your field and check whether you can subscribe to RSS feeds:

	
SOURCES I COULD SUSCRIBE TO


	Source
	RSS ?

	

	


	

	


	

	


	

	




[bookmark: _Toc440465402]How to evaluate a publication
	Write down criteria that can be used to define a "good" publication:




The Journal Citation Report (accessible from the Web of Science database), is frequently used by scientists to assess the value of journals and choose the best one to publish in:

















The Impact Factor of journals is calculated by this formula:



	Which are the highly ranked journals in your discipline and their impact factors?






Another tool that is frequently used to evaluate research is the assessment of scientists’ "performance". This performance is commonly evaluated with an indicator called h-index and calculated as follows:

A scientist with an h-index of x has published x papers each of which has been cited in other papers at least x times.

Within Web of Science, you can obtain a citation overview from a search result and get the h-index of an author with the link "Create Citation Report".
[image: ]


	What is your PhD director’s h-index within Web of Science?


Look at your neighbor’s and make hypothesis to state why it is higher/lower:





A scientist can create a personal profile in Google Scholar. If he made it, you can consult his h-index, based on publications referenced by the scientist as his own and citations of these publications within the Google Scholar database:
[image: ]


“Everything that can be counted does not necessarily count; everything that counts cannot necessarily be counted.”

Search and Evaluate - How to evaluate a publication
Albert Einstein
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Part II
Organize, Use and Publish

[bookmark: _Toc440465403]How to manage your references with EndNote

[image: K:\FORMDOC\EndNote\logo_endnote.png]


EndNote is a software which allows you to manage your bibliographic references in a database and to generate bibliographies in a word processor. You can search, integrate, organize, sort, format and export references.
If you use this kind of software when you begin a project, you can centralize, share and reuse your documents in different forms.
[image: ]

EndNote is a charged software you have to install on your desktop (Windows or MacOS). UNIGE collaborators download EndNote for free from https://gdl.unige.ch. EndNote is already installed on each PC of the library.
The current EndNote version is X7.4.

Other reference management softwares exist, such as: Zotero, Mendeley, BibTex…

Comparative table: https://mediatum.ub.tum.de/doc/1274008/1274008.pdf  



Create an EndNote library
Open EndNote and go to the menu File → New... 

WATCH OUT: An EndNote library is made up of 2 elements: a main file .enl and a folder .data with the same name containing the associated data. Always keep these elements together in the same folder!
[image: ]

	It’s your turn!
Open EndNote and create a new library.



EndNote interface
EndNote offers 3 display modes (top left). Choose the appropriate mode to work efficiently:
« Online Search » mode to search in external databases
 « Local Library » mode to work on your references (sort, publish, etc.)





 « Integrated », hybrid mode (by default)

[image: ]


In each mode, EndNote interface is made up of 3 columns:
List of references in the selected collection
List of collections (groups) and/or external databases
Detail of the selected reference






[image: ]

In the center column, the top panel allows you to launch researches in your own collections or in external databases:
[image: ]

Add references into EndNote
You have several ways to add references into EndNote:

· [image: ]Manual entry: allows you to create a reference by hand with the New Reference button. At first, you have to choose a document type (book, article, etc.). 

	It’s your turn!
Add in your library a new reference with the author Triscone, Jean-Marc. Why is this author certainly displayed in red?





· [image: ][image: ]Manual entry with a DOI (Digital Object Identifier): proceed as above to create a new Journal Article reference. Inside the reference, input only the DOI of the publication, then save with Ctrl + S. Afterwards, use the Find Reference Updates button to complete the reference from this DOI.

	It’s your turn!
Add in your library the reference with the following DOI: 10.1007/bf02467187



· Online search in EndNote: allows you to search databases (Web of Science, PubMed, etc.) directly from EndNote and to easily add references in your own library. A lot of connection files are available by default (Edit → Connection Files → Open Connection Manager) and you can add others with the Get More on the Web button.
Procedure: Switch on Online Search mode(1) and choose your database (e.g. PubMed). Use the search panel in the center column to perform your searches. Results are displayed below: select the references you wish and copy them in your own library with the Copy to Local Library button(2). (1)
(2)


[image: ]

	It’s your turn!
In Online Search mode, select the Web of Science Core Collection database. Perform a search and add the first 20 references to your library.





· Export from a database (Web of Science, PubMed, Google Scholar, SciFinder…): once you performed your search on the database, use the “Send to/Export” options and choose the “Citation Manager (RIS)” or “EndNote” format. This will directly export the file to your EndNote library. 

	It’s your turn!
Go on your most used database and perform a search. Export the first 10 references in your EndNote library.
Go on Google Scholar. On the homepage of the search engine, go to the settings, under Bibliography manager and choose to display the links to import references into EndNote. Search for an article of your choice and import the reference into EndNote.



· PDF import: if you have already downloaded a PDF file of an article on your computer, you can import it into your EndNote library. EndNote will automatically retrieve metadata (authors, title, journal, etc.) from the publication.
Procedure: File → Import → File… → Choose your file and select “PDF” in the Import Option dropdown menu.
Be careful: this technique might not always work! Always check carefully that metadata are correctly imported.

	It’s your turn!
Try to import the PDF of an article into EndNote and check its metadata (authors, title, etc.).



Get the full text of publications
[image: ]EndNote allows you to collect full text (PDF) of articles and to join it to a reference with the Find Full Text button

The 1st time, check in EndNote preferences if the settings are well defined (Edit → Preferences… → Find Full Text)  and add the UNIGE OpenURL Path: http://resolver.rero.ch/unige/.
 
[image: ]

Manage your references

	It’s your turn!
How do you organize your references into your reference manager? Can you easily retrieve publications for your current project? Discuss with your neighbor.




EndNote offers you many ways to search, arrange and sort your references:

· [image: ]Groups: by default, all references are stored in All References. References not assigned to a specific group are under Unfiled. Groups are arranged in Group Sets.
To create a group or a group set, right click in the left column → Create Group (or Group Set) → give it a name. To classify references into a group, use the drag and drop method. A reference can simultaneously be classified in several groups.

· [image: ]Smart Groups: the smart groups are created from a research in your library. The group will be automatically updated if new references added in your library match the search criteria of the smart group.
To create a smart group, right-click in the left column → Create Smart Group → give it a name and enter the search criteria. 
[image: ]

· [image: ]Create from Groups: this option allow you to create new groups from the combination of existing groups using the operators AND, OR and NOT.


· Detect duplicates: the Find Duplicates option (References → Find Duplicates) allows you to delete references imported twice. Check which is the more complete reference before deleting the duplicate.


Create bibliographies in your Word documents
You have 2 ways to create bibliographies with EndNote:
· In EndNote, choose an Output Style in the dropdown menu (e.g. Numbered), select your references, and then right click → Copy Formatted. Paste the reference list in a Word document with the shortcut CTRL + V.
· With Cite While You Write plugin (CWYW), installed in Word at the same time you installed EndNote, you can add references in your text as you are writing a report/article. The full reference list will be automatically added at the end of your text. To do this, open a Word document and use the EndNote X7 ribbon:

Insert a citation
Modify the citation style



[image: ]

About 500 styles are available in EndNote under Edit → Output Styles → Open Style Manager. You can modify a style for your specific needs or import others from EndNote website (about 5000 styles).

	It’s your turn!
1. Open a Word document. Write some words, then add a reference from your EndNote library. Add more text and more references to other publications.
2. Try different citation styles and notice the changes. 





Collaborate with EndNote Online (also EndNote Basic)
EndNote Online is a web software available from any web browser (e.g. Mozilla Firefox or Internet Explorer). This service is free with an email account @etu.unige.ch or @unige.ch.
EndNote Online offers collaboration and synchronization options not available in EndNote X7.4 alone.

Open a web browser and access EndNote Online on:
http://my.endnote.com 
If it is your 1st visit, a registration is necessary (link create an account).

Once you have got an EndNote account, you can:

· Synchronize your EndNote Desktop library with your account on EndNote Online
Procedure: In EndNote Desktop, go to Edit → Preferences… → Sync. Click on Enable Sync and give your EndNote Online login/password. After this manipulation, all your references are copied on EndNote Online and synchronized in real time.

· Share you whole library with your collegues
[image: ]Procedure: Use the Share Library button in EndNote Desktop

· Create a references group shared with your collegues
Procedure: Connect to EndNote Online; in the tab Organize → Manage My Groups, the Share column allows you to share existing groups.
[image: ]

BE CAREFUL: groups shared with you by other users are not displayed in your EndNote Desktop. You have to connect to EndNote Online to access them (category Groups Shared by Others). Moreover, attachments (e.g. PDF) can’t be shared.

	It’s your turn!
Create an EndNote Online account and synchronize your EndNote Desktop library.





[bookmark: _Toc440465404]Collaboration tools
What collaboration tools do you know?

	COLLABORATION TOOLS
	PURPOSE

	
	

	
	

	
	

	
	

	
	

	
	

	
	

	
	








[bookmark: _Toc440465405]UNIGE guidelines on plagiarism and integrity
At the University of Geneva, two guidelines specify the rights and duties of students and researchers when conducting research or writing papers:

· Directive on student plagiarism, adopted in 2011, https://memento.unige.ch/doc/0008/files/directive-on-student-plagiarism-1.pdf 
· Integrity in scientific research, adopted in 2006, www.unige.ch/recherche/files/1314/1381/9049/UNIGEGuidelinesIntegrity.pdf

Concerning the plagiarism, all UNIGE doctoral theses are checked by a similarity detection software: in order to avoid problems, reference all your sources carefully in the text using EndNote or another reference management software!


[bookmark: _Toc440465406]How to reuse and reference properly
In order to avoid plagiarism, you simply have to:

1. Put the quotations between quotation marks and reproduce with exactitude original author’s words.
2. Give the source directly after each quotation or paraphrase using either a number or the author-date mention: that refers to a full reference at the end of your document.
3. Write the list of all full references cited in your text at the end of your document. They must be sorted by numerical or by alphabetical order depending on the in-text citation format you used. Rely on publisher’s guidelines for the writing of references and insert as much information as necessary to retrieve easily the original publications.

For text-based quotations or paraphrases, following these advices is sufficient. But, if you wish to reuse previously published images or figures:

· If it’s for use inside the University of Geneva and will not be published in a journal or publicly available on the web:
you don’t have to request any author’s permission regarding the exception to author’s rights for educational purposes in the Swiss Copyright legislation.

· If it’s for the publication in a journal or on the web: 
you have to contact the journal or publisher of the source material or consult the “permissions” information that can be found on many of their web sites in order to request the permission of reuse;
Tip: asking for permission is not necessary if the original image or figure is published under a Creative Commons licence.
In all cases, you have to provide proper attribution to the source material like for text citations. 






The 7 commandments of citation*

1. I cite to acknowledge someone else’s work
2. I cite to put my work in perspective
3. I cite to re-use existing work in my own
4. I cite to help the reader to discover a new source of information or to check it
5. I only cite references that I read and understand
6. I insert in reference as much as information publisher style guidelines allows
7. I should avoid citing references to please the boss/reviewer/publisher



* Source: HENKEL Thomas and VULLIOUD Sylvie, Information Literacy for your PhD: successfully search, use and manage scientific publications, 5 November 2015. https://oer.informationskompetenz.ch/objects/LOR:3 [Accessed 7 January 2016]



[bookmark: _Toc440465407]Archive ouverte UNIGE
https://archive-ouverte.unige.ch

The Archive ouverte UNIGE is the digital repository of the University of Geneva. One of its roles is to give the largest possible access to the publications of the researchers of the institution, following the recommendations of Open Access.

All doctoral thesis, scientific articles and books published by UNIGE members must be submitted to the Archive ouverte UNIGE.
Conference proceedings, reports and master thesis may also be submitted. However, you can’t submit preprints, professional articles, posters or Powerpoint presentations.

Beyond these obligations, the diffusion of your work on this open repository offers major advantages: 

· increase of visibility of your research projects
· quick dissemination and acceleration of scientific exchanges
· guarantee of stable and enduring access to your papers
· application of the directives of the Swiss National Science Foundation concerning Open Access

Unfortunately some publishers don’t allow you to put your work online if it has just been published in one of its journals. To find out if your publishers’ copyright rules allow you to submit your publication in the Archive ouverte UNIGE, you can check in the Sherpa/RoMEO database:

www.sherpa.ac.uk/romeo 

Even if your publication can’t be publicly available according to the publishers’ copyright rules, you still have to put it in the Archive ouverte UNIGE, where you can restrict access to UNIGE community.

[bookmark: _Toc440465408]

[bookmark: _GoBack]Documentation
General purpose
Graduate information literacy module. Available from: http://www.informationliteracy.ie/ [Accessed 7 January 2016]

Evaluate
HICKS, Diana, WOUTERS, Paul, WALTMAN, Ludo, DE RIJCKE, Sarah and RAFOLS, Ismael, 2015, Bibliometrics: The Leiden Manifesto for research metrics. Nature. 2015. Vol. 520, no. 7548, p. 429–431. http://doi.org/10.1038/520429a.

Organize
THOMSON REUTERS. EndNoteTraining. http://endnote.com/training [Accessed 7 January 2016]

Use and publish
CHAM, Jorge, EISEN, Jonathan and SHOCKEY, Nick, 2012, Open Access explained! PhD TV, 2012. Available from: https://youtu.be/L5rVH1KGBCY [Accessed 7 January 2016]

[image: http://tmm.chicagodistributioncenter.com/IsbnImages/9780226116495.jpg]COUNCIL OF SCIENCE EDITORS, 2014, Scientific style and format: the CSE manual for authors, editors, and publishers. 8th ed. Chicago: University of Chicago Press. ISBN 978-0-226-11649-5. 
Call number: BELS 001.8 SCI ED8
[image: http://assets.cambridge.org/97811076/70747/cover/9781107670747.jpg]DAY, Robert A. and GASTEL, Barbara, 2008, How to write and publish a scientific paper. 7th ed. Cambridge: Cambridge University Press. ISBN 978-0-521-67167-5. 
Call number: BELS 001.8 DAY ED7
FACULTY DEVELOPMENT AND INSTRUCTIONAL DESIGN CENTER, NORTHERN ILLINOIS UNIVERSITY, 2006, Responsible authorship quick guide: detecting common mistakes and considering dilemmas in research publication. 2006. Available from: http://ori.hhs.gov/education/products/niu_authorship/ [Accessed 7 January 2016]

[image: http://ecx.images-amazon.com/images/I/41QxR5Pn5nL._SX329_BO1,204,203,200_.jpg]MURRAY, Rowena, 2013, Writing for academic journals. 3rd ed. Maidenhead: Open University Press. Open UP study skills. ISBN 978-0-335-26302-8. 
Call number: BELS 001.8 MUR ED3
[image: http://i.creativecommons.org/l/by-sa/3.0/88x31.png]Bibliothèque de l’UNIGE, 2016
This document is licensed under a Creative Commons Attribution-ShareAlike 4.0 International License: http://creativecommons.org/licenses/by-sa/4.0/deed.
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Introduction

Marine bacterial communities are recognized as major players in the ecology of coastal
ecosystems, i.e. nutrient cycling, production and decomposition of organic matter, and
the regulation of major biogeochemical cycles (1,2). Yet, they have only recently been
incorporated into the research agenda regarding the relationship between biological
diversity and ecosystem functioning (3,4). Empirical evidence of how aquatic bacterial
diversity affects ecosystem functioning in the field is still equivocal and neither the
intensity nor the outcome of their effect is well understood (5).
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